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OVERVIEW Building License Activities 

• Land Owner will contact a registered Architect/Engineer 

• Architect/Engineer will be registered with the ULB. Multiple ULB registration is possible. 

• Land owner will provide the information, documents and contract the Architect/Engineer to obtain the license based on the 

design of the Building. 

• Architect will download a software called as AutoPlan Author from the Citizen Portal – Technical Person Home. 

• This tool used to prepare the drawing. And once the design is completed, the same is checked by him for adherence for ZR 

and Byelaws requirement. Generates APZ file. 

• APZ file can be given to Land Owner to make a submission. Land owner will upload the APZ file and related documents. He 

will sign using Aadhar OTP (esign). 

• Alternatively, Architect/Engineer can also make submission on behalf of the Land Owner (depends on the contract). 

• Before submission, both needs to sign (esign). 

• Fee payment is online using Khajane 2.0. 
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Streamlined, Faster Building Plan Approval OVERVIEW 

User Registration 

Submit Application 

Prepare Application 
& Drawing 

Site Inspection 
Verify Documents Drawing Scrutiny 

Collect Fees 

Issue Certificate 

Approve 

Applicant 

Architect 

Department 
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Process Snapshot: Building Plan Approval OVERVIEW 

Building 
Application  
by Citizen 

Fee Payment  
by Citizen 

Workflow 

SUBMIT PAY ONLINE 

Fee  
Demand 

Document  
Verification 

Site Inspection 
Scheduling 

Fee  
Generation 

Fee  
Collection 

Certificate 

Endorsement 

Scrutiny /  
Verification 

Approval 

Approval 
Intimation  
to Citizen  

Issue  
Certificate 

Signing 
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Participants and Key Activities OVERVIEW 

Citizen/Applicant 

Apply for CLU / Layout 
/ Building Permit 
Approval & Fee 

Payment 

Check Status Online 

Technical Person/ 
Architect 

Prepare building / 
layout drawing & 
Perform Marking 

Generate APZ file for 
CAF upload 

 Department Officials 

Document 
Verification & 

Validation 

Payment Verification 

Approve/ Reject 
Application 

Public Agencies for NOC 

Field Verification 
through Mobile 

Provide NOC or Raise 
Objection 
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• Online Submission of Application 

• Single application for Building Permit and all clearances from PAs 

• Online Fee Payment 

• Online Download of Certificate 

• Online Status Tracking 

• Online Submission of Revised Drawings 

• Online Submission of Completion Certificate 

Automation at all levels OVERVIEW 
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System Components: Author and Web Portal OVERVIEW 

AutoPlan  
AUTHOR 

AutoPlan  
Verify Engine 

AutoPlan BPAS Citizen Portal BPAS Technical Person Portal 

BPAS Department Portal BPAS Third Party Agency Portal 

Mobile  
App 

Department 
Services 

Document 
Management 

Automated 
Workflow 

Letters & Files 

Service Level 
Monitoring 

Payment 
Gateway 

Digital 
Certificates 

SMS & Internal 
Messaging 

Citizen Services 

Document 
Management 

SMS Alerts 

Payment 
Gateway 

TP 
Services 

Document 
Management 

SMS Alerts 

Payment 
Gateway 

Agency  
Services 

Document 
Management 

SMS Alerts 

For Architects, 
Engineers & Planners  

For TP Registration 
and Renewal 

Central Engine at KMDS Data Centre, 
performs similar as Author in background 

For application processing till certificate 
generation or rejection by ULBs and UDAs 

For Site Inspection by 
Department 

For Citizens and applicants 
to submit and track permits 

For Third party agencies 
related to NOC 



AutoPlan 
Author Application 2 
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• Quick & Detailed Verification of plan with DCR and bylaws.  

• Automatic Generation of Detailed Verification Report as per Template 

• Snapshots of Drawing helping easy review of the drawing without the requirement of CAD 

Viewers 

• Acts / Rules / Laws / Development Control Rules of the Urban / Local bodies based scrutiny. 

• Option to have any number of rule sets for multiple Scenarios. 

• Easy update of rule sets. 

Automation: Scrutiny AUTHOR 
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AUTHOR Project: New Project 

• Click New Project option in File menu to create a new project 

• New Project can also be created by clicking New Project icon in Tools bar 

• Project Details form will open which contains following tabs 

– Project Information 

– Drawing File Details 

– Architect & Developer Details 

– Engineer Details 

– Ownership Details 

– Project Details 

– Land Details 

– Lease Details 
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AUTHOR Project: Project Information 

• Select the Authority to whom the project is going to be submitted 

• Enter a name for the project, short description about the project, Client Name and Application Type  

• Select Project Path to save Author Project by Selecting any existing folder or create a new folder  
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AUTHOR Project: Drawing File Details 

• Select the drawing file for which project has to be created 

• Select the details of drawing such as unit and scales 
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AUTHOR Project: Architect & Developer Details 

• Architect details will be loaded from License file details which was entered during Technical Person Registration in TPs portal. 

• Enter the details of Developer such as Name, Address, email and phone number 



16 © IDSi Technologies 2019-20 

AUTHOR Project: Engineer Details 

• Enter the details of Structural engineer and License engineer such as Name, Address, email, phone number, registration 
number and validity of registration number 
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AUTHOR Project: Ownership Details 

• Enter the details of Owners such as Name, Father name, mother name, Address, email, phone number 

• Select “Is Applicant” if the owner is the applicant and multiple owner details can be saved 
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AUTHOR Project: Project Details 

• Select the land use details of project such as Zone, Land Use category, Land Use sub category, etc. 

• Enter the details of Building such as Building Type, Building Name, Floor Details 

• Project Start and End date 

• Multiple Buildings can be saved 
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AUTHOR Drawing: Land Details 

• Enter the details of Land such as Address, Khata number, Plot Number, Plot Area Property ID Number etc.., 

• Multiple Buildings can be saved 
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AUTHOR Drawing: Lease Details 

• Enter lease if applicable 

• AutoPlan Project Zip (.apz) file can be saved by clicking finish button or  in File menu project can be saved by clicking Save 
icon in Tools bar 
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AUTHOR Drawing: Floor Details 

• Click Floor Details option in Edit menu, Select building from Building Name dropdown list 

• Select the Floors by click and hold Control key and select by mouse left click.  

• Click Typical button to convert normal floor to typical floor and click Save button 



22 © IDSi Technologies 2019-20 

AUTHOR Drawing: Connected Floor Details 

• Enter a name for the connection, select the connection type whether Simple Passage Connection or Total Area connection 
and select the building and floor to be added to connection 
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AUTHOR Drawing: Room Library 

• Select the room type under which the room has to be added to library 

• Enter the Room Name, Length, Width and Height, mark Area, Floor Level and Ceiling Level and click Save button 
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AUTHOR Drawing: Light and Ventilation Library 

• Select the opening type under which the opening has to be 
added to library 

• Enter the Opening Name, Width and Height, mark Width, Start 
and End and click Add button 
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AUTHOR Marking: Mark Site Area 

• Click Mark button corresponding to Site Area in Marking Control form 

• Enter the neighbouring details if the plot if necessary 

• Click Mark button to mark Front, Left, Right and Rear boundaries of site 

• Click Highlight button to highlight the marked site boundaries 
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AUTHOR Marking: Mark Floor Level 

• Click Mark button corresponding to Floor Level in Marking Control form 

• Mark Ground Line, Roof Line, Floor Level and Slab Bottom Level of all the floors in the building by clicking Mark button 

• Click Highlight button to highlight the marked floor levels 
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AUTHOR Marking: Mark Car Parking 

• Click Mark button corresponding to Car Parking in Marking Control form 

• Select the building, enter the number of lots and properties of lot 

• Mark the Kurb line, Parking line and mark car parking in the selected lot 

• Click Highlight button to highlight the marked car parking 
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AUTHOR Scrutiny: Verification 

• Click on Verify All button in the marking control Form or click Edit→ Verify All 

• Verify All grid will open in which all the verification items will be displayed with Required / Permissible value, Proposed value 
and Verification Status 
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AUTHOR Scrutiny: Sample Scrutiny Report 

• Click Scrutiny Report button in Verify All grid 

• Sample Scrutiny Report will be generated and saved in 
project folder 
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AUTHOR Scrutiny: Highlighting of failed verification 

• Double clicking over the verification status  

• Highlight form will open with Required / Permissible value, 
Proposed value and Verification Status and highlight the item in 
drawing 
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AUTHOR APZ file generation 

• Click Create APZ button in Marking Control form 

• APZ file will be generated  and will be saved in project folder 



AutoPlan BPAS 
Web Portal 3 
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z 

1. Click on the "Sign Up" button in the Client Portal  page. 
2. Enter the "User Registration Details". 
3. And Submit. 
4. Now you will receive an e-mail with Verification Code in 

your own e-mail account which you have provided for 
registering into BPAS Client Portal. 

5. Open the e-mail you received from BPAS Application, 
and click on the link provided in the e-mail. It will active 
the User Registration. 

Register as User WEB PORTAL 
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z 

• Technical person can be 
Architect, Structural 
Engineer, etc..  

1. Login as Registered User . 

2. Click on the Menu "New 
Technical Person 
Registration"  

3. And Enter the Details and 
submit. 

Register as Technical Person 

Citizen need not register as Technical Person 

WEB PORTAL 
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z 

1.Click on the Menu " New Building Plan 
Approval Certificate" 

 

2. Select the ULB  

 

3. And Upload the Client Utility File (generated 
by AutoPlan Author) 

 

Appling for Building Plan Permission WEB PORTAL 
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z 

• Review the application pages like Applicant, 
Land ,Project etc. and add any additional 
information required 

Verify the application Information WEB PORTAL 
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z 

Add necessary 
attachments to the 
application (this is 
configurable depending on 
the type of the application) 

 

 

Verify the application Information WEB PORTAL 
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z 

• Use the “Pay Now” Option in Application 
summary page to pay fees. 

 

 

 

 

Paying Application Fees WEB PORTAL 
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z 

• Make the Payment through 
Online Payment or Bank Challan, 
DD, NEFT etc. 

 

• Bank Challan and other payment 
modes, which is not online 
requires verification from the 
ULB. 

 

• Once the payment is done, 
applicant can submit the 
application. 

Paying Application Fees WEB PORTAL 
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• Home Page 

• List of application to be processed will be in the “Inbox” tab  

 

Department Application 

Menu Options 
View and configure the master 
settings. 
 
 
 
 
 
 
 
 
 
 

WEB PORTAL 
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z 

Department Application - Inbox 

View all applications pending for action by the user. 

WEB PORTAL 
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z 

Department Application - Sent items 

View all applications which are forwarded by the user. 

WEB PORTAL 
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z 

Application View 

On clicking the link from Inbox, application 
redirects the user to application view page. 

WEB PORTAL 
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z 

Application View - Note sheet 

Lists the entered user findings and comments for the next user along with the system generated noting. 

WEB PORTAL 
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z 

Application View - Correspondence 

View the documents  
• attached during  application submission 
• attached by the user while entering noting 
• And System generated documents 
 

WEB PORTAL 
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Workflow 

Document Verification 

Site Inspection Schedule 

Fee Generation and Payment 

Certificate  generation 

Finish 

Rejection Letter 
Sent to Applicant 

Approve Reject 

Requirement of NOCs 
submission 

Site Inspection Checklist 
verification 

WEB PORTAL 
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z 

• 1.Document Verification: Verify the document. 

• 2.Forward: Forward application to next user in workflow. 

• 3.Revert: Revert application to previous user. 

• 4.Endorsement: Revert application to applicant. 

• 5.Site Inspection: Enter details regarding site inspection. 

• 6.NOC submission: Submission of  the Required NOCs 

• 7.Checklist: Questionnaire on analysis of site inspection 

• 8.Approve/Reject: Approve or reject the application. 

• 9.Fee generation: Generate the fee details. 

• 10.Challan Upload: Upload challan for fee payment. 

• 11.Online Payment: Online payment of fees 

• 12.Certificate Generation: Generate the approval certificate. 

• 13.Finish: Conclude the workflow. 

Workflow Actions WEB PORTAL 
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z 

In each step 
• Open the application from inbox 
• Complete the actions as per the configuration for the step 
• Forward application to next level user 

Generic Activities In Each Step WEB PORTAL 
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z 

• Verifies the documents 
submitted online. 

Activity - Document verification WEB PORTAL 



50 © IDSi Technologies 2019-20 

z 

• When documents are 
missing and any issues in the 
submission, department can 
raise objection. 
 
 
 

Activity - Raise Objection WEB PORTAL 
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z 

• Allows user to raise objections, if issues are found in the application. 

Activity - Raise Objection WEB PORTAL 
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z 

• Click on the "View Status" Link for the particular Application from Listing page. 

• Click on the Button "Document Upload"  from the Application Summary. 

Responding to Objection raised from Department WEB PORTAL 
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z 

• Allows to fix a time for inspecting 
the project site and verify details 
given in the application. 

 

 

 

Activity - Site Inspection  WEB PORTAL 
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• Mobile based site inspection allow department to take photos of location 

• Checklist based processing 

• Geo-tagging of all inputs including photos and answers 

• Onsite Validation from the Applicants if device supports 

• Onsite upload to department application 

Automation of Site Inspection MOBILE APP 
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Site Inspection Survey MOBILE APP 
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z 

• Revert or send back the 
application to previous user. 

 

 

 

Activity - Revert WEB PORTAL 
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z 

• Allows approval of the 
application. 

 

 

 

Activity - Approve WEB PORTAL 
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z 

• Allows rejection of the application. 

 

 

 

Activity - Reject WEB PORTAL 
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z 

• Allows to generate sanction fees for 
the application as per configured 
fee heads. 

 

 

 

Activity - Fee Generation WEB PORTAL 
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z 

Allows to enter the 
details of payment 
which is not made 
through online payment 
system. 

Activity - Sanction Fee Payment WEB PORTAL 
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z 

• 1. Select the menu "Building Plan Approval" 
• 2. Select the Sub menu " Payment Verification" 
• 3. Click on the hyperlink of  Application Code 
• 4. Select the Check Box and Click on the "Accept" Button. 
• 2 

Activity - Payment verification WEB PORTAL 



LBPAS 
Impact 4 
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Differences from Manual Processing 

Area of Operation Manual Automated 

Application Paper based application Online submission through Citizen Portal 

Site Inspection 
Manual co-ordination or sequential inspection 

by related agencies 

Joint scheduling and inspection with information 

sharing through work portal 

Fee Payment Payment at bank and submit challan Online payment 

Approval Manual verification of papers at each desk  
Movement of files through workflow with 

approval 

Communication Visitor / Telephone based enquiry desk Status shared online and through SMS to applicant 

Certificate 
Paper certificate with seal and manual 

signature 

Computer generated certificate with digital 

signature 

IMPACT 
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What got changed? IMPACT 

FROM Manual Verification TO Automatic Verification 

FROM Several Days of Processing TO Few Hours of Processing 
Reduced time taken 
for scrutiny imply 

Computerized verification 
of Building Plans ensure 
there are 

No  
Errors 

No  
Bottlenecks 
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What got changed? IMPACT 

Convenient payment modes 
of citizen’s choice means 

TO Quick Online Payment FROM Cash Counter Lines 

Change in plans between 
resubmissions suggest 

FROM Difficult to Trace Changes TO Easy Change Tracking 

No  
Troubles 

No  
Drawbacks 
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What got changed? IMPACT 

No  
Hassles 

No  
Hang-ups 

TO Online Submission FROM Manual Submission 

FROM Telephone Calls TO Mobile Alerts 
With automatic SMS alerts on 
the status of your application 

Submit your application 
sitting at home with  
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Benefits to all stakeholders IMPACT 

• Reduced manual effort in scrutiny of drawings and 

lesser errors in verification of applications  

• FIFO logic removes partisan approach 

• Savings on stationery and paper: Go Green 

• Reduced application processing time, and improved 

service levels and quality 

• Reduced work backlog / pending applications 

• Enhanced transparency in public governance 

• Integration with governmental systems assures 

validated data 

• No need to visit office to submit application 

• One time document verification 

• CAD Drawing can be checked for compliance with 

byelaws before submitting 

• Therefore, reduced chances of revised submissions 

• Convenience of online payment to the services 

• Can track status of application online 

• In case of endorsements, re-submit on portal itself 

• No waiting time in queues 

• No telephonic follow up with needed officials 

To Government To Citizen 
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What just got better? IMPACT 

Verification 
Accuracy 

Convenience to 
citizen 

Approval 
Timeframe 

Manual Errors 

Transparency of 
service 

Cost per 
transaction 
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Translating to Benefits IMPACT 

# Impact Benefit 

1 
Timeframe for building permit reduces by 
60% to 80% 

Increase in EODB Ranking  
[Parameter: Dealing with Construction Permits] 
Karnataka jumped from 15 to 7 – (2018) 
Verified by UDD, DIPP (EODB) Delhi. 

2 
Applicant no more required to visit 
different offices 

Happy Citizens 

3 
Site inspection allows to picture the site 
and share it 

Improved Transparency 

4 
Applicants can verify the drawing 
themselves (2 modes) 

Drastic reduction in applications rejection or 
NIL 
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Multidimensional Influences IMPACT 

Helps to enhance the EODB Rankings of 
the ULB, State and Country. 

Automated Fire NOC is a key component in providing better services 
to citizens under the smart city mission by Government of India. 

CITIZEN 

ARCHITECT TP OFFICIAL 

Fire Dept. 

System B System A 

Fostering an ecosystem for civic governance Lending a helping hand to the economy 



Thank You 


